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Function

1. Introduction

A function is a predefined formula that performs calculations
using specific values in a particular order. Excel includes many
common functions that can be wused to quickly find
the sum, average, count, maximum value, and minimum
value for a range of cells. In order to use functions correctly,
you'll need to understand the different parts of a function and
how to create arguments to calculate values and cell
references.

2. The parts of a function

In order to work correctly, a function must be written a
specific way, which is called the syntax. The basic syntax for a
function is the equals sign (=), the function name (SUM, for
example), and one or more arguments. Arguments contain the
information you want to calculate. The function in the example
below would add the values of the cell range A1:A20.

Equals sign
|
=SUM(A1:A20)
S ~ J NS ~ A
Function name Argument
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3. Working with arguments

Arguments can refer to both individual cells and cell
ranges and must be enclosed within parentheses. You can
include one argument or multiple arguments, depending on the
syntax required for the function.

For example, the function =AVERAGE(B1:B9) would calculate
the average of the values in the cell range B1:B9. This function
contains only one argument.

NETWORK... ¥ X « S || =AVERAGE(BL:B9)

A B c | D | E

(= R < B B = T R Y R
R R R - R A

=AVERAGE(B1:B9)

iy
- |

Multiple arguments must be separated by a comma. For
example, the function =SUM(A1:A3, C1:C2, ET) will add the
values of all of the cells in the three arguments.

A5 - > L4 5 =SUM(A1:A3,C1:C2,E1)

A B C D | E | F
4 6 I 20l

o0
[ary
=)

[= RN TR S TE R T
| I—|

I=SUM[A1:A3,C1:C2,E1}
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4. Creating a function

There are a variety of functions available in Excel. Here are
some of the most common functions you'll use:

« SUM: This function adds all of the values of the cells in the
argument.

. AVERAGE: This function determines the average of the values
included in the argument. It calculates the sum of the cells and
then divides that value by the number of cells in the argument.

« COUNT: This function countsthe number of cells with
numerical data in the argument. This function is useful for
quickly counting items in a cell range.

« MAX: This function determines the highest cell value included
in the argument.

« MIN: This function determines the lowest cell value included in
the argument.

5. To create a function using the AutoSum command:

The AutoSum command allows you to automatically insert the
most common functions into your formula, including SUM,
AVERAGE, COUNT, MAX, and MIN. In the example below, we'll
use the SUM function to calculate the total cost for a list of
recently ordered items.

1. Select the cell that will contain the function. In our example,
we'll select cell D13.
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D13 & I
A | B | C D

2_

3 |Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
5 |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 (Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
8 |Lime Juice (1 gallon) 5 $11.99 $59.95
o ‘Tomato Juice (case of 10) 3 $19.49 S58.47
10 Hot Sauce (1 gallon) 8 §7.35 $58.80
11 Salsa, Medium (1 gallon) 12 $8.47 $101.64
12 Olive Qil (2.5 gallon) 4 $28.69 $114.76
14 |

2. In the Editing group on the Home tab, click the arrow next to

the AutoSum command. Next, choose the desired
function from the drop-down menu. In our example, we'll
select Sum.

Em Ex iil 2 AutoSu w O

M S
- Insert Delete Format E — ms nd 8
=" - - - Average
- Sum (Alt+=)
ells
Count Numbers Automatically add it up. Your total
Max 3 will appear after the selected cells,
Min 6
l 0] p 5
T T I More Functions... —
5
=sUM(J2:J5)

3. Excel will place the function in the cell and automatically select
acell rangefor the argument. In our example,
cells D3:D12 were selected automatically; their values will
be added to calculate the total cost. If Excel selects the wrong
cell range, you can manually enter the desired cells into the
argument.
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NETWORK... ¥ i X « fe | =SUM(D3:D12)

A A B T D

2 | ITEM QUANTITY  UNIT PRICE LINE TOTAL O
3 | Tomatoes (case of 12) 3 $17.44 §52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
s |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 |Corn Meal/Maza (25 |b.) 5 $18.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
& |Lime Juice (1 gallon) 5 $11.99 $59.95
9 |Tomato Juice (case of 10) 3 $19.49 $58.47
10 |Hot Sauce (1 gallon) 8 $7.35 $58.80
11 |Salsa, Medium (1 gallon) 12 $8.47 $101.64
12 |Olive Qil (2.5 gallon) 4 $28.69 $114.76

SUM({number1, [number2], ..}

4. Press Enter on your keyboard. The function will be calculated,
and the result will appear in the cell. In our example, the sum of
D3:D12 is $765.29.

D13 - fe || =SUM(D3:D12)
A B z D

P [TEM QUANTITY  UNIT PRICE  LINE TOTAL O
3 | Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
5 |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 |Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
s |Lime Juice (1 gallon) 5 $11.99 $59.95
9 |Tomato Juice (case of 10) 3 $19.49 $58.47
10 |Hot Sauce (1 gallon) 8 $7.35 $58.80
11 |Salsa, Medium (1 gallon) 12 $8.47 $101.64
12 |Olive Qil (2.5 gallon) 4 $28.69 $114.76

. $765.29

The AutoSum command can also be accessed from
the Formulas tab on the Ribbon.

Home [E Page Data Review View ell me what you want
GG B @8 S S

S Use in Formu

Insert  AutoSum Recently Financial Logical Text Date& Lookup & Math &  Mare MName
Function - Used ~ - - ~  Time~ Reference~ Trig~ Functions~ Manager £ Create from €
2 Sum Function Library Defined Mames
p1z | Average | £ =SUM(D3:D12)
1 Count Numbers [
A Max B C D
2 i QUANTITY UNITPRICE LINETOTAL O
3 |Tom More Functions... 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
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You can also use the Alt+= keyboard shortcut instead of the
AutoSum command. To use this shortcut, hold down the Alt key
and then press the equals sign.

6. To enter a function manually:

If you already know the function name, you can easily type it
yourself. In the example below (a tally of cookie sales), we'll use
the AVERAGE function to calculate the average number of units
sold by each troop.

1. Select the cell that will contain the function. In our example,
we'll select cell C10.

C10 - e
A B C
j Frontier Kids Cookie Sales
5 Troop Name Troop ID Units Sold
3 |North Bend #3506 1004
4 | Silver Lake #2745 938
5 | Mountain Top #1038 745
6 Rocky Trail #3759 729
7 Forest Path #4157 862
8 | Green Valley #1932 890
g |River View #4233 775
. Average Units op
1

2. Type the equals sign (=), then enter the desired function name.
You can also select the desired function from the list
of suggested functions that appears below the cell as you type.
In our example, we'll type =AVERAGE.
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NETWORK... ™ X « S || =AVERAGE
A B C
1 Frontier Kids Cookie Sales
: Troop Name Troop ID Units Sold
3 MNorth Bend #3506 1004
4 | Silver Lake #2745 938
5 | Mountain Top #1038 745
6 Rocky Trail #3759 729
7 | Forest Path #4157 862
g Green Valley #1932 890
g | River View #4233 175
10 Average Units =AVERAGE
— Returns the aver
1 'f;‘:' contain number
B () AVERAGEA
12 (%) AVERAGEIF
13 () AVERAGEIFS
14

3. Enter the cell range for the argument inside parentheses. In our
example, we'll type (C3:C9). This formula will add the values
of cells C3:C9, then divide that value by the total number of
values in the range.

C10 - X « fo | =AVERAGE([C3:C9)
A B C
. Frontier Kids Cookie Sales
, |Troop Name Troop ID Units Sold
3 North Bend #3506 1004
4 Silver Lake #2745 938
5 | Mountain Top #1038 745
& Rocky Trail #3759 729
7 Forest Path #4157 862
8 | Green Valley #1932 890
g River View #4233 175
10 Average Units =AVERAGE(C3:C9)
11

4. Press Enter on your keyboard. The function will be calculated,
and the result will appear in the cell. In our example, the
average number of units sold by each troop is 849.
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c10 v J« | =AVERAGE(C3:C9)
A B C
M Frontier Kids Cookie Sales
- Troop Name Troop ID Units Sald
3 North Bend #3506 1004
4 Silver Lake #2745 938
5 | Mountain Top #1038 745
6 Rocky Trail #3759 729
7 Forest Path #4157 862
8 | Green Valley #1932 890
g |River View #4233 775
10 Average Units 849
1

7. The Function Library

While there are hundreds of functions in Excel, the ones you'll
use the most will depend on the type of data your workbooks
contain. There's no need to learn every single function, but
exploring some of the different types of functions will help as
you create new projects. You can even use the Function
Library on the Formulas tab to browse functions by category,
including Financial, Logical, Text, and Date & Time.

To access the Function Library, select the Formulas tab on
the Ribbon. Look for the Function Library group.

Click the buttons in the interactive below to learn more about
the different types of functions in Excel.
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File Home Insert Page Layout Formulas Data Review View Q@ Tell me what you want to do...
=3, C=lDefineName -
X BEREOERIOE S°
fx Use in Farmula
Insert  AutoSum Recently Financial Log\(al Text Date & Lookup & Math &  Mare Name
Function - Used ~ - ~  Time~ Reference~ Trig~ Functions~ Manager [ Create from Selection
Function Library Defined Mames
R28 & F
A E C D E F G H J K
] —
2 —
3 —
4_
El —
6_
7_
8_
9_
10

8. To insert a function from the Function Library:

In the example below, we'll use the COUNTA function to count
the total number of items in the ltems column. Unlike
COUNT, COUNTA can be used to tally cells that contain data of
any kind, not just numerical data.

1. Select the cell that will contain the function. In our example,
we'll select cell B17.

B17 < l
A B C | D

2_

3 |Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
s |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 |Corn Meal/Maza (25 Ib.) 5 518.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
s |Lime Juice (1 gallon) 5 $11.99 $59.95
s |Tomato Juice (case of 10) 3 $19.49 $58.47
10 |Hot Sauce (1 gallon) 8 $7.35 $58.80
11 |Salsa, Medium (1 gallon) 12 $8.47 5101.64
12|Olive Qil (2.5 gallon) 4 $28.69 $114.76

13 TOTAL $765.29

17|Total items ordered an

13| Most expensive item
18 | Average days in transit
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2. Click the Formulas tab on the Ribbon to access the Function
Library.

3. From the Function Library group, select the desired function
category. In our example, we'll choose More Functions, then
hover the mouse over Statistical.

age Layou rmulas ata i i Q Tell me what you want to do...
o ' = & Define Name - = Trace Prece
= _ . -

fx Usein Formula ok Trace Depe
Financial Log\:al Text Date & Lookup & Math & Maore Mame
- Time~ Reference~ Trig ~ JFunctions = Manager {5 Create from Selection &REMWQA’
Function Library I, Statistical + AVEDEV
I} Engineering™ » AVERAGE
% Cube 4 AVERAGEA
E € 1 o Information  » AVERAGEIF 'i
i B Compatibility » AVERAGEIFS i
of 12) 3 SR web v BETA.DIST 1
2 of 10) 5 $20.14 $S10 BETAINV 1
r(501b.) 5 $14.05 S7 BINOM.DIST 1
| (25 |b} 5 $18.69 59 BINOM.DIST.RANGE 1
b.) 5 $10.99 gg o 1
CHISQ.DIST
|OI"I) 5 sll'gg SS CHISQ.DIST.RT :
ise of 10) 3 $15.49 85 oy 1
lon) 2 $7.35 S5 CHISQINVRT z
1 gallon) 12 $8.47 $10 CHISQ.TEST
|OI"I) 4 $28.69 $11 CONFIDENCE.NORM
TOTAL S7ﬁ CONFIDENCET
CORREL

4. Select the desired function from the drop-down menu. In our
example, we'll select the COUNTA function, which will count
the number of cells in the Items column that are not empty.

Page Layout Formulas Data Review View Q Tell me what you want te do...
o =:. (=l Define Name ~ %1 Trace Prece
L L L L L L B‘ iy Use in Formula n:ETra:e Depe
oo et e, v S s | ekt
Function Library B statistical — » CONFIDENCE.NORM [+]
L'R Engineering  * COMNFIDENCE.T
% Cube 3 CORREL
B € 1 e Information  » COUNT li
[ Compatiiity » COUNTA | Hi
of 12} 3 $] L% e ' COUNTA(valuel,value2,) 1
zof 10} > S2014 S].O Counts the number of cellsin a
r (50 Ib.) 5 $14.05 $7 | rangethat are not empty
(25 1b.) 5 $18.69 59 | @ Tellmemore
b.) 5 $10.99 5 oo 1
lon) 5 $11.99 $5 EXPON.DIST :
ise of 10) 3 $19.49 S5 EDIST 1
lon) 8 $7.35 $5 F.DIST.RT Z
1 gallon) 12 58.47 $10 R
lon) 4 $28.69 §11  FINVRT
ToTAlL  S70[E
FISHER
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5. The Function Arguments dialog box will appear. Select
the Valuel field, then enter or select the desired cells. In our
example, we'll enter the cell range A3:A12. You can continue to
add arguments in the Value?2 field, but in this case we only want
to count the number of cells in the cell range A3:A12.

6. When you're satisfied, click OK.

Function Arguments ? x

COUNTA
Valuel | A3:a12
WalueZ

| &

{Tomatoes (case of 12)";"Black Bean... I

number

= 10
Counts the number of cells in a range that are not empty.

Valuei: valuelvaluel,... are 1to 255 arguments representing the values and cells
you want to count. Values can be any type of information.

Formula result = 10

Help on this function cancel

7. The function will be calculated, and the result will appear in the
cell. In our example, the result shows that 10 items were

ordered.

o - P

A B C | D |
2,
3 Tomatoes (case of 12) 3 $17.44 $52.32
4 Black Beans [case of 10) 5 $20.14 $100.70
5 All Purpose Flour (S0 Ib.) 5 $14.05 $70.25
& Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 Brown Rice (25 Ib.) 5 $10.99 $54.95
g |Lime Juice (1 gallon) 5 $11.99 $59.95
9 Tomato Juice (case of 10) 3 $19.49 $58.47
10 Hot Sauce (1 gallon) 3 $7.35 $58.80
11 Salsa, Medium (1 gallon) 12 $8.47 $101.64
12 Olive Qil (2.5 gallon) 4 $28.69 $114.76

13 TOTAL 5765.29
14
15

16

ITJ Total items ordered m

12 Most expensive item

19 Average days in transit

20
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9. The Insert Function command

While the Function Library is a great place to browse for
functions, sometimes you may prefer to search for one instead.
You can do so using the Insert Function command. It may take
some trial and error depending on the type of function you're
looking for, but with practice the Insert Function command can
be a powerful way to find a function quickly.

10. To use the Insert Function command:

In the example below, we want to find a function that will
calculate the number of business days it took to receive items
after they were ordered. We'll use the dates in
columns E and F to calculate the delivery time in column G.

1. Select the cell that will contain the function. In our example,
we'll select cell G3.

G3 b F
A E . F G H
2
5 |Tomatoes (case of 12) 12-Oct 15—Oct| > |
4 |Black Beans (case of 10) 12-Oct 17-Oct
5 |All Purpose Flour (50 Ib.) 12-Oct 14-Oct
6 Corn Meal/Maza (25 Ib.) 12-Oct 15-Oct
7 |Brown Rice (25 Ib.) 12-Oct 15-Oct
8 |Lime Juice (1 gallon) 16-Oct 20-Oct
¢ 'Tomato Juice (case of 10) 16-Oct 19-Oct
10 Hot Sauce (1 gallon) 16-Oct 20-Oct
11 |Salsa, Medium (1 gallon) 19-Oct 23-Oct
12 Olive Oil (2.5 gallon) 19-Oct 24-0Oct
13

2. Click the Formulas tab on the Ribbon, then click the Insert
Function command.
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Home Insert Page Layout Formulas Data Review View Q Tell me what you want to do.,
[ =. (=lDefine Name ~
B > = RO 8 5
L\\? - - - “fx Use in Formula

Insert ' AutoSum Recently Financial Logical Text Date & Lookup & Math&  More Name _

Function - Used ~ - e +  Time~ Reference~ Trig~ Functions~ Manager [5 Create from Selectio
Function Library Defined Mames
Insert Function (Shift+F3) £

Waork with the fermula in the
current cell. Yeou can easily pick E F G H
functions to use and get help on

how to fill cut the input values, |

__ @ Tellme more 12-Oct 15‘0Ct| l

4 |Black Beans {case of 10) 12-Oct 17-Oct

3. The Insert Function dialog box will appear.

4. Type a few keywords describing the calculation you want the
function to perform, then click Go. In our example, we'll
type count days, but you can also search by selecting
a category from the drop-down list.

Insert Function ? *
Search for a function:

Or select a category: | All ~

Select a function:

ACCRINT

ACCRINTM

ACOS

ACOSH

ACOT

ACOTH >

ABS{number)
Returns the absolute value of a number, a number without its sign.

Help on this fundion QK Cancel

5. Review the results to find the desired function, then click OK.
In our example, we'll choose NETWORKDAYS, which will
count the number of business days between the ordered date and
received date.
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Insert Function ? x

Search for a function:

count days Go

Or select a category: | Recommended A

Select a function:

MINVERSE
MRULT
METWORKDAYS.IMNTL

CODDFPRICE
WORKDAY, INTL
METWORKDAYS

art_date d_date, holidays,
Returns the number of whole workdays between two dates.

Help on this fundion Cancel

6. The Function Arguments dialog box will appear. From here,
you'll be able to enter or select the cells that will make up the
arguments in the function. In our example, we'll enter E3 in
the Start_date field and F3 in the End_date field.

7. When you're satisfied, click OK.

Function Arguments ? *
NETWORKDAYS
Start_date | E3 FRs| = 42289
End_date F3 FRs| = 42292
Holidays Rzl = any
= 4

Returns the number of whole workdays between two dates,

End_date isa serial date number that represents the end date,

Formula result = 4

Help on this function Cancel

8. The function will be calculated, and the result will appear in the
cell. In our example, the result shows that it took four business
days to receive the order.
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G3

F || =NETWORKDAYS(E3,F3)

A E F G H

2

s |Tomatoes (case of 12) 12-Oct 15—Oct| 4]
4 |Black Beans (case of 10) 12-Oct 17-Oct

5 |All Purpose Flour (50 Ib.) 12-Oct 14-Oct

6 |Corn Meal/Maza (25 Ib.) 12-Oct 15-Oct

7 |Brown Rice (25 Ib.) 12-Oct 15-Oct

s |Lime Juice (1 gallon) 16-Oct 20-Oct

¢ |Tomato Juice (case of 10) 16-Oct 19-Oct

10|Hot Sauce (1 gallon) 16-Oct 20-Oct

11|Salsa, Medium (1 gallon) 19-Oct 23-Oct

12 |Olive Oil (2.5 gallon) 19-Oct 24-Oct

13

Like formulas, functions can be copied to adjacent cells.
Simply select the cell that contains the function, then click and
drag the fill handle over the cells you want to fill. The function

will be copied, and values for those cells will be calculated

relative to their rows or columns.

G3

= | =NETWORKDAYS(E3,F3)

A E F G H

2

; |Tomatoes (case of 12) 12-Oct 15—0ct| é
4 |Black Beans (case of 10) 12-Oct 17-Oct

5 |All Purpose Flour (50 Ib.) 12-Oct 14-Oct

6 Corn Meal/Maza (25 Ib.) 12-Oct 15-Oct

7 |Brown Rice (25 Ib.) 12-Oct 15-Oct

s |Lime Juice (1 gallon) 16-Oct 20-Oct

s |Tomato Juice (case of 10) 16-Oct 19-Oct

10| Hot Sauce (1 gallon) 16-Oct 20-Oct

11|Salsa, Medium (1 gallon) 19-Oct 23-Oct

12| Olive Qil (2.5 gallon) 19-Oct 24-Oct v
13
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